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PENGENALAN WINDOWS SERVER 2008 

  

 Windows Server 2008 merupakan sistem operasi generasi 

penerus Windows Server 2003 yang telah disempurnakan. Windows 

Server 2008 menawarkan beragam fitur baru dan keamanan yang 

lebih dibanding Windows server sebelumnya. Beberapa fitur baru 

yang ada di Windows Server 2008 adalah: 

1. Server Core. 

2. Internet Information Services 7.0. 

3. Server Virtualization (Hyper-V). 

4. Internet Protocol Version 6. 

5. Read-only Domain Controllers. 

6. Server Manager. 

7. Windows Deployment Services. 

8. Network Access Protection. 

9. Windows Advanced Firewall dan Policy Based QoS. 

10. Secure Socket Tunneling Protocol (SSTP). 

 

Terdapat 5 versi Windows Server 2008 yaitu: 

1. Windows Server 2008 Standard Edition, merupakan system 

operasi yang ditujukan untuk organisasi skala kecil hingga 

menengah.  
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2. Windows Server 2008 Enterprise Edition, merupakan system 

operasi yang ditujukan untuk organisasi dengan skala besar. 

3. Windows Server 2008 Datacenter Edition, merupakan system 

operasi yang ditujukan untuk organisasi dengan skala yang 

sangat besar yang melibatkan operasi transaksi dan data 

warehouse. 

4. Windows Web Server 2008, merupakan system operasi yang 

ditujukan untuk memberikan layanan web hosting dan aplikasi 

web. 

5. Windows Server 2008 for Itanium-Based Systems, merupakan 

sistem operasi yang ditujukan untuk sistem berbasis processor 

Intel Itanium 2 64 bit. 

 

INSTALASI WINDOWS SERVER 2008 

 

Sebelum melakukan instalasi, sebaiknya anda memeriksa 

hardware yang dimiliki apakah mendukung untuk menjalankan 

Windows Server 2008. Anda dapat melihat daftar hardware-hardware 

yang didukung oleh Windows Server 2008 melalui alamat 

http://www.microsoft.com/whdc/winlogo/HWrequirements.mspx atau 

navigasi melalui homepage Microsoft Windows Server 2008 dengan 

alamat http://www.microsoft.com/windowsserver2008. 

http://www.microsoft.com/whdc/winlogo/HWrequirements.mspx
http://www.microsoft.com/windowsserver2008
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Microsoft menyarankan hardware minimum untuk menjalankan 

Windows Server 2008 sebagai berikut: 

1. Processor: 1 GHz untuk processor x86 atau 1,4 GHz untuk 

processor x64 (disarankan 2 GHz atau yang lebih cepat). Edisi 

Windows Server 2008 for Itanium-Based Systems 

membutuhkan processor Intel Itanium 2. 

2. Memory (RAM): 512 MB disarankan 2 GB atau yang lebih besar. 

Untuk sistem 32 bit, edisi Windows Server 2008 Standard 

mendukung memory maksimum 4 GB sedangkan edisi Windows 

Server 2008 Enterprise dan Datacenter mendukung memory 

maksimum 64 GB. Untuk system 64 bit, edisi Windows Server 

2008 Standard mendukung memory maksimum 32 GB 

sedangkan edisi Windows Server 2008 Enterprise, Datacenter, 

dan Itanium-based Systems mendukung memory maksimum 2 

TB. 

3. Kapasitas hardisk: minimum 10 GB, disarankan 40 GB atau 

yang lebih besar. 

4. DVD-ROM Drive. 

5. Monitor: Super VGA 800 X 600 resolution atau resolusi yang 

lebih tinggi. 
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Tahapan Instalasi Windows Server 2008 

1. Konfigurasi BIOS pada komputer yang akan diinstall Windows 

Server 2008 agar melakukan booting melalui DVD-ROM. 

2. Masukkan DVD-ROM instalasi Windows Server 2008 ke DVD-

ROM Drive dan restart komputer. 

3. Setelah komputer melakukan restart, komputer akan 

melakukan booting melalui DVD-ROM, selanjutnya akan tampil 

kotak dialog pengaturan bahasa, format waktu dan mata uang 

serta jenis keyboard, seperti ditunjukkan pada gambar berikut: 

 

 Lakukan pengaturan, dan klik tombol Next. 

4. Tampil kotak dialog untuk memulai proses instalasi, klik tombol 

Install Now, seperti ditunjukkan pada gambar berikut: 
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5. Tampil kotak dialog Type your product key for activation, 

untuk memasukkan product key, seperti ditunjukkan pada 

gambar berikut: 
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Masukkan product key pada isian parameter Product key 

(dashes will be added automatically): dan klik tombol 

Next. 

6. Tampil kotak dialog Select the operating system you want 

to install, untuk memilih jenis system operasi yang akan 

diinstalasi, seperti ditunjukkan pada gambar berikut: 

 

Pilih system operasi yang akan diinstalasi, dan klik tombol 

Next. 

7. Tampil kotak dialog Please read the license terms, yang 

menampilkan informasi lisensi, seperti ditunjukkan pada 

gambar berikut: 
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Cek pada parameter I accept the license terms untuk 

menyetujui lisensi, dan klik Next. 

8. Tampil kotak dialog Which type of installation do you 

want?, untuk memilih jenis instalasi mana yang Anda inginkan, 

seperti ditunjukkan pada gambar berikut: 

 



 

Building Domain Controller Using Windows Server 2008 

Hak cipta © 2016 www.iputuhariyadi.net 8 

Terdapat pilihan Upgrade dan Custom (advanced). Pilih 

Custom (advanced). 

9. Tampil kotak dialog Where do you want to install windows? 

untuk menentukan lokasi partisi instalasi Windows Server 2008, 

seperti ditunjukkan pada gambar berikut: 

 

Anda dapat juga membuat partisi secara manual, dengan 

melakukan klik pada parameter Drive options (advanced). 

Pilih partisi lokasi instalasi dan klik tombol Next. 

10. Tampil kotak dialog Installing Windows… yang menampilkan 

informasi instalasi Windows Server 2008 dimulai, seperti 

ditunjukkan pada gambar berikut: 
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Tunggu instalasi beberapa menit. Komputer melakukan restart. 

11. Setelah selesai restart, akan tampil kotak dialog dengan 

parameter The user’s password must be changed before 

logging on the first time, seperti ditunjukkan pada gambar 

berikut: 
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Klik tombol OK. 

12. Tampil kotak dialog untuk mengatur password user 

Administrator, seperti ditunjukkan pada gambar berikut: 

 

Masukkan password pada isian dengan keterangan New 

Password dan Confirm Password, dan tekan Enter. 

13. Tampil kotak dialog dengan parameter Your password has 

been changed. Klik tombol OK. 

14. Tampil Desktop Windows. Selamat Anda telah berhasil 

menginstalasi Windows Server 2008 . 
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IP Address merupakan alamat yang digunakan untuk 

mengidentifikasi komputer yang terhubung ke Internet atau ke 

jaringan. IP address versi 4 (IPv4) memiliki panjang 32 bit dan 

dibagi menjadi dua bagian yaitu Network ID dan Host ID. Network 

ID digunakan untuk menunjukkan alamat jaringan, sedangkan Host 

ID digunakan untuk menunjukkan alamat host. Dalam penulisannya 

IPv4 menggunakan empat kelompok nilai decimal yang dipisah 

dengan tanda titik, sering disebut dotted decimal notation, sebagai 

contoh 192.168.1.254. Setiap host di jaringan memiliki alamat IP 

yang unik. 

IP Address dibagi menjadi 5 class untuk mempermudah 

pendistribusiannya yaitu A, B, C, D dan E. Ketentuan untuk 3 class 

pertama adalah: 

1. Class A 

Network ID (8 bit) Host ID (24 bit) 

0nnnnnnn hhhhhhhh hhhhhhhh hhhhhhhh 

2. Class B 

Network ID (16 bit) Host ID (16 bit) 

10nnnnnn nnnnnnnn hhhhhhhh hhhhhhhh 

3. Class C 

Network ID (24 bit) Host ID (8 bit) 

110nnnnn nnnnnnnn nnnnnnnn hhhhhhhh 
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Tabel berikut menampilkan nilai desimal di oktet pertama yang 

menunjukkan class alamat IPv4: 

Class Antara Jumlah 

Jaringan 

Jumlah Host 

Per Jaringan 

A 1 s/d 126 126 16.777.214 

B 128 s/d 191 16.384 65.534 

C 192 s/d 223 2.097.152 254 

 

Subnetmask 

 

Merupakan sebuah nilai yang digunakan untuk memisahkan 

antara Network ID dan Host ID dari sebuah alamat. Ketentuan 

subnetmask adalah semua bit di bagian Network ID diatur ke biner 1, 

sedangkan semua bit di bagian Host ID diatur ke biner 0. Sehingga 

masing-masing class IP address memiliki nilai default subnetmask 

seperti ditunjukkan pada tabel berikut: 

Tabel Default Subnetmask 

Class Default Subnet Mask 

A 255.0.0.0 

B 255.255.0.0 

C 255.255.255.0 
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Alamat Broadcast 

Alamat broadcast diperlukan untuk menghubungi seluruh host 

di sebuah jaringan dan mencari informasi di jaringan. 

Terdapat 2 jenis alamat broadcast, yaitu: 

1. Local Broadcast 

Berupa alamat khusus 255.255.255.255, yang berarti 

mengirim paket untuk seluruh simpul di jaringan lokal. 

2. Directed Broadcast 

Bit untuk host adalah binary 1 semua, misal untuk Class B 

alamat 172.16.255.255 yang berarti mengirim paket ke seluruh 

simpul yang berada di jaringan 172.16.0.0. 

 

Private IP Address 

IANA (International Assigned Numbers Authority) 

mengelompokkan IP Address yang dinyatakan “private”, artinya 

hanya digunakan di jaringan lokal dan tidak berlaku di Internet.  

Tabel IP Address Private 

Class Alamat IP 

A 10.0.0.0 s/d 10.255.255.255 

B 172.16.0.0 s/d 172.31.255.255 

C 192.168.0.0 s/d 192.168.255.255 
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Konfigurasi Protokol TCP/IP versi 4 pada Windows Server 

2008 

1. Klik tombol Start > Network > Network and Sharing 

Center > Manage network connections.  

2. Klik dua kali pada  koneksi yang akan diatur, tampil kotak 

dialog seperti ditunjukkan pada gambar berikut: 

 

3. Klik tombol Properties, tampil kotak dialog Local Area 

Connection Properties, seperti ditunjukkan pada gambar 

berikut: 
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Pada Tab Networking parameter “This connection uses the 

following items:”, pilih “Internet Protocol Version 4 

(TCP/IPv4)”, kemudian klik tombol Properties. Tampil kotak 

dialog Internet Protocol Version 4 (TCP/IPv4) Properties. 

3. Pada tab General, terdapat dua pilihan untuk mengatur alamat 

IP yaitu “Obtain an IP address automatically” untuk 

pengalokasian alamat secara dinamis, dan “Use the following 

IP Address” untuk pengalokasian alamat secara statik. Pilih 

“Use the following IP Address”, masukkan IP Address, 

Subnet mask, dan Default gateway yang digunakan, seperti 

ditunjukkan pada gambar berikut: 
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Pada tab General juga terdapat dua pilihan untuk mengatur 

Domain Name System (DNS) yaitu “Obtain DNS Server 

automatically” untuk pengalokasian alamat DNS secara 

dinamis, dan “Use the following DNS Server addresses” 

untuk pengalokasian alamat DNS secara statik. Pilih “Use the 

following DNS Server addresses”, masukkan Preffered 

DNS Server, dan Alternate DNS Server. Setelah selesai klik 

tombol OK > OK > Close. 

 

 

 



 

Building Domain Controller Using Windows Server 2008 

Hak cipta © 2016 www.iputuhariyadi.net 17 

Tes konfigurasi TCP/IP versi 4 pada Windows Server 2008 

 

Tes konfigurasi TCP/IP dilakukan untuk menguji apakah 

komputer Anda dapat berhubungan dengan komputer lainnya dalam 

jaringan. Utilitas ping dapat digunakan untuk menguji konfigurasi 

TCP/IP, berikut langkah-langkahnya: 

1. Klik tombol Start > Command Prompt. Tampil aplikasi 

Command Prompt. 

2. Sintak penggunaan utilitas ping adalah PING ALAMAT_IP. 

Contoh penggunaan utilitas ping, ditunjukkan seperti pada 

gambar berikut: 
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Active Directory merupakan layanan direktori yang menyimpan 

informasi mengenai objek-objek di jaringan dan membuat informasi 

ini tersedia bagi user dan administrator jaringan.  

Fungsi dari Active Directory adalah memusatkan pengaturan 

sumber daya jaringan, manajemen sumber daya secara terpusat dan 

tersebar, menyimpan objek-objek dengan aman pada struktur logical, 

dan mengoptimalkan trafik jaringan. 

Active Directory terdiri dari komponen-komponen yang 

merupakan struktur logical dan physical. Struktur logical dari Active 

Directory meliputi objects, organizational units (OU), domain, 

domain tree, dan forest. Sedangkan struktur physical dari Active 

Directory terdiri dari domain controller, dan sites. 

 

Active Directory Namespace 

Namespace yang digunakan di Active Directory mengikuti skema 

penamaan Domain Name System (DNS). DNS merupakan sistem 

yang melakukan translasi nama host ke alamat IP dan sebaliknya. 

DNS dibutuhkan untuk menemukan lokasi domain controller yang 

menjalankan Windows Server 2008. DNS server yang menggunakan 

Windows Server 2008 dapat menggunakan Active Directory untuk 

menyimpan dan mereplikasi zone. 
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Penamaan Active Directory 

Terdapat 4 jenis penamaan di Active Directory yaitu: 

1. Distinguished Name (DN) merupakan nama yang unik dari 

semua objek dan memuat informasi lengkap yang dibutuhkan 

untuk mengakses objek. DN terdiri dari domain dimana objek 

tersebut berada dan path dari objek. DN dibentuk dari atribut-

atribut berikut: 

 Domain Component (DC) 

 Organizational Unit (OU) 

 Common Name (CN) 

Sebagai contoh untuk mengakses user dengan nama wulan 

yang berada di OU Marketing, di domain intra.net, maka DN-

nya adalah: /DC=net/DC=intra/OU=marketing/CN=wulan 

2. Relative Distinguished Name (RDN) merupakan Common 

Name (CN) dari Distinguished Name (DN) yang mendefinisikan 

objek aktual disebut atribut. Untuk melakukan pencarian objek 

hanya perlu mengetahui Common Name (CN). 

3. Globally Unique Identifiers (GUID) merupakan nomor unik 

128 bit diberikan ke objek ketika dibuat di Active Directory. 

4. User Principal Name (UPN) merupakan nama logon 

pengguna dan nama domain yang mengidentifikasi domain 

dimana pengguna tersebut berada. Ini merupakan standar 
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penggunaan untuk login ke domain Windows. Format penulisan 

seperti alamat email sebagai contoh someone@intra.net. 

 

Global Catalog 

Active Directory domain controller memelihara global catalog dengan 

tujuan agar pengguna jaringan dan aplikasi-aplikasi dapat mencari 

dan menemukan objek-objek di Active Directory berdasarkan atribut-

atribut tertentu. Global catalog menyimpan sebagian replika dari 

objek dan atribut yang paling umum. Data di global catalog dibangun 

dan dipelihara melalui proses replikasi diantara domain controller.  

 

Instalasi Server Role Active Directory Domain Services pada 

Windows Server 2008 

 

Langkah-langkah instalasi server role Active Directory Domain 

Services pada Windows Server 2008 adalah sebagai berikut: 

1. Klik tombol Start > Server Manager, tampil aplikasi Server 

Manager. Pada panel sebelah kiri pilih Roles > klik Add Roles 

pada Roles Summary di panel sebelah kanan, seperti 

ditunjukkan pada gambar berikut: 

mailto:someone@intra.net


 

Building Domain Controller Using Windows Server 2008 

 

Hak cipta © 2016 www.iputuhariyadi.net 21 

 

2. Tampil kotak dialog Add Roles Wizard, klik tombol Next > 

tampil kotak dialog Select Server Roles. Pada parameter 

Select one or more roles to install on this server, cek pada 

pilihan Active Directory Domain Services, seperti 

ditunjukkan pada gambar berikut: 
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kemudian klik tombol Next.  

3. Tampil kotak dialog Active Directory Domain Services yang 

memberikan pengenalan mengenai Active Directory Domain 

Services, klik tombol Next. 

4. Tampil kotak dialog Confirm Installation Selections, yang 

menampilkan konfirmasi server role yang akan diinstalasi 

dalam hal ini adalah Active Directory Domain Services, klik 

tombol Install untuk memulai instalasi. 

5. Tampil kotak dialog Installation Results, menampilkan 

informasi hasil instalasi server role Active Directory Domain 

Services, klik tombol Close dan selanjutnya gunakan Active 

Directory Domain Services Installation Wizard 
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(dcpromo.exe) untuk membuat server yang berfungsi sebagai 

Domain Controller, seperti ditunjukkan pada gambar berikut: 

 

Langkah-langkah instalasi Active Directory Domain Controller di 

Windows Server 2008 adalah sebagai berikut: 

1. Klik tombol Start > Run, ketik dcpromo untuk menjalankan 

Active Directory Domain Services Installation Wizard. 

2. Tampil kotak dialog Welcome to the Active Directory 

Domain Services Installation Wizard, klik Next. 

3. Tampil kotak dialog Choose a Deployment Configuration, 

yang digunakan untuk menentukan apakah akan membuat 

domain controller untuk forest yang telah ada atau untuk forest 

yang baru. Pilih Existing forest, untuk membuat domain 
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controller untuk forest yang telah ada. Sebaliknya, pilih Create 

a new domain in a new forest, untuk membuat domain 

controller untuk forest baru, seperti ditunjukkan pada gambar 

berikut: 

 

Sebagai contoh pilih Create a new domain in a new forest 

dan klik Next. 

4. Tampil kotak dialog Name the Forest Root Domain, yang 

digunakan untuk mengatur nama forest sebagai contoh 

intra.net. Domain pertama di forest adalah forest root domain 

dan namanya juga adalah nama dari forest, seperti ditunjukkan 

pada gambar berikut: 
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Kemudian klik Next. 

5. Tampil kotak dialog Set Forest Functional Level, yang 

digunakan untuk memilih forest functional level. Forest 

functional level digunakan untuk menentukan kemampuan dari 

Active Directory Domain Services yang akan tersedia di domain 

atau forest. Juga membatasi sistem operasi Windows Server 

mana saja yang dapat berjalan pada domain controller-domain 

controller di domain atau forest. Pada parameter Forest 

functional level, pilih functional level yang akan digunakan. 

Pilihan yang ada antara lain Windows 2000, Windows 
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Server 2003, dan Windows Server 2008, seperti 

ditunjukkan pada gambar berikut: 

 

Sebagai contoh pilih Windows Server 2008, kemudian klik 

Next. 

6. Tampil kotak dialog Additional Domain Controllers Options,  

digunakan untuk memilih pilihan-pilihan instalasi tambahan 

untuk domain controller selama instalasi Active Directory 

Domain Services, seperti instalasi service DNS Server atau 

membuat server global catalog atau Read-Only Domain 

Controller (RODC). Pada parameter Select additional options 

for this domain controller, cek pada pilihan-pilihan instalasi 
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tambahan yang diinginkan, sebagai contoh cek pada pilihan 

DNS Server, seperti ditunjukkan pada gambar berikut:  

 

kemudian klik Next. 

7. Tampil kotak yang menginformasikan bahwa delegasi untuk 

DNS Server ini tidak dapat dibuat karena authoritative parent 

zone tidak ditemukan atau tidak menjalankan Windows DNS 

Server. Jika Anda mengintegrasikan dengan infrastruKtur DNS 

yang telah ada, Anda harus secara manual membuat delegasi 

untuk DNS Server ini di zone parent untuk memastikan resolusi 

penamaan yang dapat diandalkan dari luar domain yang dibuat 

sebagai contoh intra.net. Sebaliknya, tidak ada aksi yang 
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diperlukan. Apakah Anda ingin melanjutkan? Pilihan yang 

tampil adalah Yes atau No. Sebagai contoh pilih Yes, seperti 

ditunjukkan pada gambar berikut: 

 

8. Tampil kotak dialog Location for Database, Log Files, and 

SYSVOL, yang digunakan untuk menentukan lokasi direktori-

direktori yang akan menyimpan database, log files, dan sysvol 

dari Active Directory. Pada parameter Database folder:, 

masukkan lokasi direktori dimana database Active Directory 

disimpan. Pada parameter Log files folder:, masukkan lokasi 

direktori dimana log files Active Directory disimpan. Pada 

parameter Sysvol folder:, masukkan lokasi direktori dimana 

sysvol Active Directory disimpan, seperti ditunjukkan pada 

gambar berikut: 
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Kemudian klik Next. 

9. Tampil kotak dialog Directory Services Restore Mode 

Administrator Password, yang digunakan untuk mengatur 

password Administrator saat menjalankan Windows Server 

2008 pada mode Directory Service Restore Mode. Pada 

parameter Password: dan Confirm Password:, masukkan 

sandi bagi user Administrator, seperti ditunjukkan pada gambar 

berikut: 
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kemudian klik Next. 

10. Tampil kotak dialog Summary, yang menampilkan ringkasan 

dari isian parameter-parameter yang dimasukkan pada 

langkah-langkah sebelumnya. Klik Next untuk memulai 

instalasi. 

11. Restart komputer. 

 

Instalasi Active Directory Additional Domain Controller 

 

Langkah-langkah instalasi Active Directory Additional Domain 

Controller di Windows Server 2008 adalah sebagai berikut: 
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1. Klik tombol Start > Run, ketik dcpromo untuk menjalankan 

Active Directory Domain Services Installation Wizard. 

2. Tampil kotak dialog Welcome to the Active Directory 

Domain Services Installation Wizard, klik Next. 

3. Tampil kotak dialog Choose a Deployment Configuration, 

yang digunakan untuk menentukan apakah akan membuat 

domain controller untuk forest yang telah ada atau untuk forest 

yang baru. Pilih Existing forest, untuk membuat domain 

controller untuk forest yang telah ada. Pilih Create a new 

domain in a new forest, untuk membuat domain controller 

untuk forest baru, seperti ditunjukkan pada gambar berikut: 
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Untuk membuat additional domain controller pilih Existing 

forest. Selanjutnya terdapat dua parameter lanjutan yaitu 

pilihan pertama Add a domain controller to an existing 

domain (digunakan untuk menambahkan domain controller ke 

domain yang telah ada) dan pilihan kedua Create a new 

domain in an existing forest (digunakan untuk membuat 

domain baru di forest yang telah ada). Sebagai contoh pilih Add 

a domain controller to an existing domain, dan klik Next. 

4. Tampil kotak dialog Network Credentials, yang digunakan 

untuk menentukan nama dari forest dimana instalasi akan 

terjadi dan nama pengguna dan sandi yang mempunyai hak 

akses yang cukup untuk melakukan instalasi. Pada parameter 

Type the name of any domain in forest where you plan to 

install this domain controller:, masukkan nama domain, 

sebagai contoh intra.net, seperti ditunjukkan pada gambar 

berikut: 
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Selanjutnya klik tombol Set … Tampil kotak dialog Windows 

Security, masukkan nama pengguna dan sandi yang memiliki 

hak akses untuk melakukan instalasi, sebagai contoh nama 

pengguna adalah administrator, seperti ditunjukkan pada 

gambar berikut:  
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dan klik OK > klik tombol Next. 

5. Tampil kotak dialog Select a domain, yang digunakan untuk 

memilih nama domain untuk additional domain controller yang 

dibuat. Pada parameter Domain:, pilih nama domain sebagai 

contoh intra.net, seperti ditunjukkan pada gambar berikut: 
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Kemudian klik tombol Next. 

6. Tampil kotak dialog Select a Site, yang digunakan untuk 

memilih Site untuk domain controller baru yang dibuat. Pada 

parameter Sites:, pilih site, sebagai contoh site Amerika, 

seperti ditunjukkan pada gambar berikut: 
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Kemudian klik Next. 

7. Tampil kotak dialog Additional Domain Controller Options, 

yang digunakan untuk memilih opsi-opsi tambahan lainnya 

untuk domain controller ini. Pada parameter Select additional 

options for this domain controller, terdapat tiga pilihan 

yang dapat dipilih yaitu DNS Server, Global Catalog, dan 

Read-Only Domain Controller (RODC). Sebagai contoh cek 

pada pilihan DNS Server, dan Global Catalog, seperti 

ditunjukkan pada gambar berikut: 
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Kemudian klik tombol Next. 

8. Tampil kotak yang menginformasikan bahwa delegasi untuk 

DNS Server ini tidak dapat dibuat karena authoritative parent 

zone tidak ditemukan atau tidak menjalankan Windows DNS 

Server. Jika Anda mengintegrasikan dengan infrastruKtur DNS 

yang telah ada, Anda harus secara manual membuat delegasi 

untuk DNS Server ini di zone parent untuk memastikan resolusi 

penamaan yang dapat diandalkan dari luar domain yang dibuat 

sebagai contoh intra.net. Sebaliknya, tidak ada aksi yang 

diperlukan. Apakah Anda ingin melanjutkan? Pilihan yang 

tampil adalah Yes atau No. Sebagai contoh pilih Yes. 
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9. Tampil kotak dialog Location for Database, Log Files, and 

SYSVOL, yang digunakan untuk menentukan lokasi direktori-

direktori yang akan menyimpan database, log files, dan sysvol 

dari Active Directory. Pada parameter Database folder:, 

masukkan lokasi direktori dimana database Active Directory 

disimpan. Pada parameter Log files folder:, masukkan lokasi 

direktori dimana log files Active Directory disimpan. Pada 

parameter Sysvol folder:, masukkan lokasi direktori dimana 

sysvol Active Directory disimpan, seperti ditunjukkan pada 

gambar berikut: 
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10. Tampil kotak dialog Tampil kotak dialog Directory Services 

Restore Mode Administrator Password, yang digunakan 

untuk mengatur password Administrator saat menjalankan 

Windows Server 2008 pada mode Directory Service Restore 

Mode. Pada parameter Password: dan Confirm Password:, 

masukkan sandi bagi user Administrator, seperti ditunjukkan 

pada gambar berikut: 
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11. Tampil kotak dialog Summary, yang menampilkan ringkasan 

dari isian parameter-parameter yang dimasukkan pada 

langkah-langkah sebelumnya. Klik Next untuk memulai 

instalasi. 

12. Restart komputer. 
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Windows Server 2008 menyediakan utilitas Active Directory Users 

and Computers yang digunakan untuk mengatur objek-objek di 

Active Directory seperti pembuatan, perubahan, dan penghapusan 

objek user, group, komputer, shared folder, dan organizational unit. 

 

Manajemen User 

Langkah-langkah untuk membuat user baru di Active Directory 

adalah sebagai berikut: 

1. Klik tombol Start > Administrative Tools > Active 

Directory Users and Computers (ADUC). 

2. Tampil aplikasi ADUC, pada panel sebelah kiri, klik kanan pada 

container Users, pilih New > User, tampil kotak dialog New 

Object – User, seperti ditunjukkan pada gambar berikut: 
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Lengkapi parameter-parameter berikut: 

 First name:, masukkan nama depan pengguna. 

 Initials:, masukkan inisial pengguna. 

 Last name:, masukkan nama belakang pengguna. 

 Full name:, masukkan nama lengkap pengguna. 

 User logon name:, masukkan nama logon pengguna. 

 User logon name (pre-Windows 2000):, masukkan 

nama logon pengguna untuk komputer client dengan 

sistem operasi sebelum Windows 2000. 

Klik tombol Next. 

3. Tampil kotak dialog untuk memasukkan sandi pengguna dan 

mengatur ketentuan password dan status account pengguna 

yang dibuat, seperti ditunjukkan pada gambar berikut: 
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Masukkan sandi pengguna di isian parameter Password: dan 

Confirm password:. Terdapat beberapa pengaturan ketentuan 

password dan account pengguna yang dapat dipilih yaitu: 

 User must change password at next logon, 

digunakan untuk mengatur agar pengguna harus 

mengganti sandi saat logon pertama kali. 

 User cannot change password, digunakan untuk 

mengatur agar pengguna tidak dapat mengganti sandi. 

 Password never expires, digunakan untuk mengatur 

agar sandi berlaku selamanya. 

 Account is disabled, digunakan untuk menonaktifkan 

account pengguna yang dibuat. 

Sebagai contoh cek pada pilihan “Password never expires” 

dan klik tombol Next > Finish. 

 

Manajemen Group 

Langkah-langkah untuk membuat group baru di Active Directory 

adalah sebagai berikut: 

1. Klik tombol Start > Administrative Tools > Active 

Directory Users and Computers (ADUC). 

2. Tampil aplikasi ADUC, pada panel sebelah kiri, klik kanan pada 

container Users, pilih New > Group, tampil kotak dialog New 

Object – Group, seperti ditunjukkan pada gambar berikut: 
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Lengkapi parameter-parameter berikut: 

 Group name:, masukkan nama group yang dibuat. 

 Group name (pre-Windows 2000):, masukkan nama 

group untuk komputer client dengan sistem operasi 

sebelum Windows 2000. 

 Group scope:, pilih jangkauan group yang dibuat apakah 

Domain Local (dapat beranggotakan pengguna dari 

domain sembarang, tetapi dapat mengakses sumber daya 

dimana group tersebut dibuat), Global (dapat 

beranggotakan pengguna dimana group tersebut dibuat 

dan mengakses sumber daya di domain sembarang), atau 

Universal (dapat beranggotakan dari domain sembarang 

dan mengakses sumber daya di domain sembarang). 
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 Group type:, pilih jenis group apakah Security (group 

yang digunakan untuk mengatur ijin akses terhadap 

sumber daya) atau Distribution (group yang digunakan 

untuk mendistribusikan sebagai contoh email ke sebuah 

group). 

Klik tombol OK. 
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File Sharing 

 

Langkah-langkah membuat folder yang akan dibagi pakai adalah 

sebagai berikut: 

1. Klik kanan pada tombol Start > pilih Explore. Tampil aplikasi 

Windows Explorer. Tentukan lokasi penyimpanan folder yang 

akan dibagi pakai, sebagai contoh ditempatkan di drive C. 

2. Pada menubar Windows Explorer pilih menu menu File > New 

> Folder, untuk membuat folder yang akan dibagi pakai, 

sebagai contoh beri nama “laporan”. 

3. Klik kanan pada folder “laporan” yang telah dibuat, pilih 

Share... > tampil kotak dialog File Sharing seperti ditunjukkan 

pada gambar berikut: 

 

Pada menu drop down dengan parameter Choose people on 

your network to share with, pilih pengguna-pengguna yang 

diijinkan untuk mengakses folder laporan yang dibagi pakai, 
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sebagai contoh pilih Everyone > klik tombol Add. Dibawah 

paramater Permission Level, klik tanda panah disebelah 

kanan dari nama pengguna atau group yang akan diatur ijin 

aksesnya dan pilih salah satu dari pengaturan ijin akses bagi 

pakai yang ada, seperti ditunjukkan pada gambar berikut: 

 

 Klik Reader untuk membatasi pengguna atau group 

melihat file-file di folder yang dibagi pakai. 

 Klik Contributor untuk mengijinkan pengguna atau 

group untuk melihat semua file-file, menambah file-file 

dan mengubah atau menghapus file-file yang mereka 

tambahkan. 

 Klik Co-owner untuk mengijinkan pengguna atau group 

untuk melihat, mengubah, menambah dan menghapus 

file-file di folder yang dibagi pakai. 

Kemudian klik tombol Share. 

4. Tampil kotak dialog yang menerangkan folder telah berhasil 

dibagi pakai, seperti ditunjukkan pada gambar berikut: 
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klik tombol Done. 

 

Printer Sharing 

 

Langkah-langkah menginstalasi dan melakukan bagi pakai printer 

adalah sebagai berikut: 

1. Klik tombol Start > Control Panel > klik dua kali pada 

Printers. Tampil kotak dialog Printers, seperti ditunjukkan 

pada gambar berikut: 
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Pada toolbar klik Add a Printer untuk menambahkan printer. 

2. Tampil kotak dialog Add Printer, pada parameter Choose a 

local or network printer, pilih printer yang akan ditambahkan 

terpasang di komputer lokal atau printer jaringan/printer 

wireless, seperti ditunjukkan pada gambar berikut: 

 

Pilih Add a local printer, jika printer yang akan diinstalasi 

terpasang di komputer lokal. Sebaliknya pilih Add a network, 

wireless, or Bluetooth printer, jika printer yang akan 

diinstalasi lokasinya di jaringan atau jenisnya printer 

wireless/bluetooth. Sebagai contoh pilih Add a local printer. 

3. Tampil kotak dialog Choose a printer port, untuk menentukan 

jenis koneksi (port komunikasi) yang mengijinkan komputer 

Anda berkomunikasi dengan printer, sebagai contoh pilih Use 

an existing port: LPT1 (Printer Port), seperti ditunjukkan 

pada gambar berikut: 
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Kemudian klik tombol Next. 

4. Tampil kotak dialog Install the printer driver, untuk memilih 

pembuat dan model printer yang digunakan, seperti 

ditunjukkan pada gambar berikut: 
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Pilih pembuat printer yang digunakan pada bagian 

Manufacturer, dan pilih model printer yang digunakan pada 

bagian Printers. Sebagai contoh pilih Canon pada bagian 

Manufacturer dan pilih Canon Buble-Jet BJC-1000 pada 

paramter Printers. Klik tombol Next. 

5. Tampil kotak dialog Type a printer name, yang digunakan 

untuk mengatur nama printer, dan mengatur default printer. 

Pada parameter Printer name:, masukkan nama printer 

sebagai contoh Canon, dan cek pada parameter Set as default 

printer, jika printer ini diinginkan sebagai printer default, 

seperti yang ditunjukkan pada gambar berikut: 

 

6. Tampil kotak dialog Printer Sharing, yang digunakan untuk 

mengatur bagi pakai printer. Pilih Do not share this printer, 

jika printer tidak ingin dibagi pakai. Sebaliknya pilih Share this 

printer so that others on your network can find dan use 

it, jika printer ingin dibagi pakai. Sebagai contoh pilih Share 
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this printer so that others on your network can find dan use it. 

Selanjutnya lengkapi paramater-parameter berikut: 

 Share name:, digunakan untuk mengatur nama 

pengenal printer yang  dibagi pakai, sebagai contoh 

Canon. 

 Location:, digunakan untuk memasukkan informasi 

lokasi printer. 

 Comment: digunakan untuk memasukkan keterangan 

tambahan mengenai printer yang dibagi pakai. 

Seperti ditunjukkan pada gambar berikut: 

 

Kemudian klik tombol Next. 

7. Tampil kotak dialog You’ve successfully added Canon, yang 

menginformasikan printer telah sukses diinstalasi. Klik tombol 

Print a test page, untuk melakukan tes pencetakan, seperti 

ditunjukkan pada gambar berikut: 
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Klik tombol Finish. 
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Dynamic Host Configuration Protocol (DHCP) merupakan 

protokol yang digunakan untuk mendistribusikan alamat IP, subnet 

mask, dan parameter lainnya seperti alamat default gateway, DNS, & 

WINS, secara dinamis kepada komputer client. 

 

 

 

DHCP terdiri dari dua komponen yaitu Server DHCP dan Client 

DHCP. Server DHCP merupakan komputer yang bertindak sebagai 

pendistribusi alamat IP, sedangkan client DHCP merupakan komputer 

yang menyewa atau meminta layanan alamat IP ke server DHCP. 
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Instalasi dan Konfigurasi Server DHCP pada Windows Server 

2008 

 

Langkah-langkah instalasi dan konfigurasi server DHCP pada 

Windows Server 2008 adalah sebagai berikut: 

1. Klik tombol Start > Server Manager, tampil aplikasi Server 

Manager. Pada panel sebelah kiri pilih Roles > klik Add Roles 

pada Roles Summary di panel sebelah kanan, seperti 

ditunjukkan pada gambar berikut: 

 

2. Tampil kotak dialog Add Roles Wizard, klik tombol Next > 

tampil kotak dialog Select Server Roles. Pada parameter 

Select one or more roles to install on this server, cek pada 

pilihan DHCP Server, seperti ditunjukkan pada gambar 

berikut: 
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kemudian klik tombol Next.  

3. Tampil kotak dialog DHCP Server yang memberikan 

pengenalan mengenai DHCP Server Role, klik tombol Next. 

4. Tampil kotak dialog Select Network Connection Binding, 

yang mendeteksi koneksi-koneksi jaringan yang telah diatur 

dengan alamat IP statik. Pada parameter Network 

Connections: pilih koneksi-koneksi jaringan dimana DHCP 

server digunakan untuk memberikan layanan ke DHCP Client, 

seperti ditunjukkan pada gambar berikut: 
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 Kemudian klik tombol Next. 

5. Tampil kotak dialog Specify IPv4 DNS Server Settings, 

untuk mengatur Domain Name System (DNS). Pada parameter 

Parent Domain: masukkan nama domain yang digunakan, 

pada parameter Preferred DNS Server IPv4 Address: 

masukkan alamat IP server DNS utama (primary), pada 

paramter Alternate DNS Server IPv4 Address: masukkan 

alamat IP server DNS lainnya (secondary), seperti ditunjukkan 

pada gambar berikut: 
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kemudian klik tombol Next. 

6. Tampil kotak dialog Specify IPv4 WINS Server Settings, 

untuk mengatur alamat IP dari Server WINS. Pilih pada 

paramater WINS is not required for applications on this 

network, apabila Anda tidak menggunakan server WINS. Pilih 

pada parameter WINS is required for applications on this 

network, apabila Anda menggunakan server WINS, 

selanjutnya masukkan alamat IP dari server WINS pertama 

pada parameter Preferred WINS Server IP Address, dan 

masukkan alamat IP dari server WINS kedua pada parameter 

Alternate WINS Server IP Address:, seperti ditunjukkan 

pada gambar berikut: 
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kemudian klik tombol Next. 

7. Tampil kotak dialog Add or Edit DHCP Scopes, untuk 

mengatur jangkauan alamat IP yang akan didistribusikan 

secara dinamis. Klik tombol Add, tampil kotak dialog Add 

Scope, lengkapi parameter-parameter berikut: 

 Scope Name, digunakan untuk menentukan nama ruang 

alamat IP yang disewakan. 

 Starting IP Address, digunakan untuk menentukan 

alamat IP awal yang akan disewakan ke client. 

 Ending IP Address, digunakan untuk menentukan 

alamat IP akhir yang akan disewakan ke client. 



 

Building Domain Controller Using Windows Server 2008 

 

Hak cipta © 2016 www.iputuhariyadi.net 59 

 Subnet Mask, digunakan untuk menentukan alamat 

subnetmask dari alamat jaringan yang disewakan ke 

client. 

 Default Gateway, digunakan untuk menentukan alamat 

IP dari router agar dapat berkomunikasi ke beda jaringan. 

 Subnet Type, digunakan untuk menentukan jenis subnet 

apakah jaringannya mengunakan media kabel (dengan 

masa sewa 6 hari) atau wireless (dengan masa sewa 8 

jam). 

 Activate This Scope, digunakan untuk langsung 

mengaktifkan scope yang dibuat. 

seperti yang ditunjukkan pada gambar berikut: 
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klik tombol OK > hasil pengaturan scope ditunjukkan seperti 

pada gambar berikut: 

 

Untuk melakukan perubahan pada scope yang telah dibuat klik 

pada tombol Edit, sedangkan untuk menghapus scope klik pada 

tombol Delete. Kemudian tombol klik Next. 

8. Tampil kotak dialog Configure DHCPv6 Stateless Mode. 

DHCP Server mendukung protocol DHCPv6 untuk melayani 

client-client IPv6. Menggunakan DHCPv6, client-client dapat 

secara otomatis mengatur alamat-alamat IPv6 mereka 

menggunakan mode stateless, atau mereka dapat memperoleh 

alamat IPv6 di mode stateful dari DHCP Server. Jika router-

router pada jaringan Anda dikonfigurasi untuk mendukung 
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DHCPv6, verifikasi pilihan agar sesuai dengan konfigurasi dari 

router. Pada parameter Select the DHCPv6 stateless mode 

configuration for this server:, pilih Enable DHCPv6 staless 

mode for this server, jika IPv6 dari client-client akan secara 

otomatis dikonfigurasi tanpa menggunakan DHCP Server, pilih 

Disable DHCPv6 stateless mode for this server, setelah 

instalasi DHCP Server, Anda dapat mengkonfigurasi mode 

DHCPv6 menggunakan DHCP Management Console, seperti 

ditunjukkan pada gambar berikut: 

 

Kemudian klik tombol Next. 
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9. Tampil kotak dialog Confirm Installation Selections, yang 

menampilkan ringkasan konfigurasi DHCP Server, klik tombol 

Install untuk menginstalasi service DHCP. 

10. Tampil kotak dialog Installation Results, menampilkan 

informasi hasil instalasi server DHCP, klik tombol Close. 

 

Konfigurasi Windows Server 2008 sebagai DHCP Client 

 

Langkah-langkah konfigurasi Windows Server 2008 sebagai 

DHCP Client adalah sebagai berikut: 

1. Klik tombol Start > Network > Network and Sharing 

Center > Manage network connections.  

2. Klik dua kali pada  koneksi yang akan diatur, tampil kotak 

dialog seperti ditunjukkan pada gambar berikut: 
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3. Klik tombol Properties, tampil kotak dialog Local Area 

Connection Properties, seperti ditunjukkan pada gambar 

berikut: 
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Pada Tab Networking parameter “This connection uses the 

following items:”, pilih “Internet Protocol Version 4 

(TCP/IPv4)”, kemudian klik tombol Properties. Tampil kotak 

dialog Internet Protocol Version 4 (TCP/IPv4) Properties. 

4. Pada tab General, pilih “Obtain an IP address 

automatically” untuk pengalokasian alamat secara dinamis, 

dan pilih “Obtain DNS Server automatically” untuk 

pengalokasian alamat DNS secara dinamis, seperti ditunjukkan 

pada gambar berikut: 
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Setelah selesai klik tombol OK > OK > Close. 

 



 

 

 

 

 

REPLIKASI ACTIVE DIRECTORY 

 

 

 

 

 

 

 

 

 

7 

 



 

Building Domain Controller Using Windows Server 2008 

 

Hak cipta © 2016 www.iputuhariyadi.net 66 

Replikasi merupakan proses memperbaharui informasi di Active 

Directory dari satu domain controller ke domain controller lainnya di 

jaringan. Proses replikasi mensinkronisasi perpindahan informasi 

yang diperbaharui diantara domain controller. Active Directory 

menggunakan konsep site untuk mengatur trafik replikasi.  

Terdapat 2 jenis replikasi di Active Directory yaitu:  

a. Intrasite Replication (Replikasi antar domain controller yang 

berada di satu site). 

b. Intersite Replication (Replikasi antar domain controller yang 

berada di site yang berbeda). 

 

Konfigurasi Intrasite Replication pada Windows Server 2008  

 

Active Directory menyediakan aplikasi Active Directory Sites 

and Services untuk mengatur replikasi antar domain controller. 

Aplikasi ini dapat diakses melalui menu Start > Administrative 

Tools > Active Directory Site and Services.  

Setelah instalasi Active Directory, komputer server yang bertindak 

sebagai domain controller dan additional domain controller berada 

dalam satu site yaitu Default-First-Site-Name.  

Berikut ini dicontohkan cara mengatur konfigurasi replikasi 

intrasite untuk domain intra.net. Diasumsikan terdapat 2 server 

domain controller yang mengatur domain tersebut, berlokasi di 
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Amerika, dan memiliki alamat jaringan (network id) 192.168.1.0/24, 

seperti ditunjukkan pada gambar dibawah ini: 

 

Langkah-langkah mengkonfigurasi intrasite replication untuk 

domain intra.net adalah sebagai berikut: 

1. Melalui menu Start > Administrative Tools > klik pada 

Active Directory Site and Services (ADSS). 

2. Tampil aplikasi ADSS, navigasi ke panel sebelah kiri, pilih Sites 

> klik kanan pada Default-First-Site-Name, pilih Rename, 

ubah nama site menjadi Amerika. 

3. Navigasi ke panel sebelah kiri, pilih Sites > Subnets. Klik 

kanan pada Subnets > New Subnet untuk membuat subnet 

sesuai dengan alamat jaringan yang digunakan. Tampil kotak 
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dialog New Object – Subnet, atur parameter-parameter 

berikut: 

 Prefix::, masukkan alamat jaringan (network id) yang 

digunakan dan subnetmask dengan menggunakan format 

penulisan bit count yaitu 192.168.1.0/24. 

 Select a site object for this subnet, pilih nama site 

yang diasosiasikan dengan alamat jaringan yang dibuat, 

pilih site Amerika. 

Selanjutnya klik tombol OK. 

4. Navigasi ke panel sebelah kiri, pilih Sites > Amerika > 

Servers > klik kanan pada Redmond, pilih Properties. 

Tampil kotak dialog Redmond Properties, pada pilihan 

parameter Transports available for inter-site data 

transfer: pilih IP sebagai transport, klik tombol “Add >>” > 

klik tombol OK. 

5. Tes konfigurasi replikasi intrasite dengan cara membuat objek 

baru sebagai contoh user baru pada server domain controller 

melalui aplikasi Active Directory Users and Computers. 

Selanjutnya cek pada server additional domain controller 

apakah object baru yang dibuat telah berhasil direplikasi. 
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